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NOTICES

Licensing

THIS  PRODUCT  IS  LICENSED  UNDER  THE  WIRELESS  NETWORK  PATENT 
PORTFOLIO LICENSE FOR USE BY A CONSUMER OR OTHER USES FOR WHICH 
THERE IS NO REMUNERATION.  ANY OTHER USE OF THIS PRODUCT IN ANY 
MANNER  IS  NOT  LICENSED  AND  IS  EXPRESSLY  PROHIBITED  WITHOUT  A 
LICENSE UNDER APPLICABLE PATENTS IN THE WIRELESS NETWORK PATENT 
PORTFOLIO,  WHICH  LICENSE  IS  AVAILABLE  FROM  MPEG LA,  LLC,  4600  S. 
ULSTER  ST.,  SUITE  400,  DENVER,  COLORADO  80237  U.S.A.   SEE 
HTTP://WWW.MPEGLA.COM

Patents

This product contains MeshPlus and/or StarPlus Technologies that are licensed by the 
manufacturer and are protected by US Patents including: 7782804, 7996534, 8126488, 
8351409, 8428558, 8428630.  The furnishing of this document and/or purchasing of the 
associated products does not give you any license to or ownership of such patents.

Copying

No part of this manual or associated hardware or software products may be reproduced in 
any form or by any means including, without limitation, electronic or mechanical such as 
photocopying or recording, or by any information storage and retrieval systems without the 
express written consent of Zenner USA.  Specifications are subject to change without notice.
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FCC Compliance

Note: This equipment has been tested and found to comply with the limits for a Class B 
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference in a residential installation. 
This equipment generates, uses and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful interference 
to radio communications. However, there is no guarantee that interference will not occur 
in a particular installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the 
user is encouraged to try to correct the interference by one or more of the following 
measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the 

receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

CONTAINS FCC ID: VE4-MM8-P

Caution: Changes or modifications not expressly approved by the manufacturer 
could void the user’s authority to operate the equipment. Only the manufacturer 
supplied antenna is approved for operation with the equipment.

NOTE: Changes or modifications not expressly approved by the manufacturer 
could void the user's authority to operate the equipment
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RF Exposure 

User should hold the SmiRF in such a manner as to maintain a distance greater than 
30mm (1.2 inches) between the user's hand and the antenna, which is mounted in the 
top cover of the SmiRF.
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Introduction
MeshPlus® networks are used for remote monitoring and control of commercial, industrial, and 
municipal equipment such as automatic utility metering, municipal lighting, and traffic 
management.  Hundreds of thousands of devices are currently being monitored and controlled by 
MeshPlus® networks.  

The MeshPlus® handheld RF System Manager (SMiRF®) is used by installers and field service 
technicians to deploy and manage MeshPlus MIU devices such as utility meter interface units 
(MIUs).  With a SMiRF®, MIUs may be easily installed, upgraded, checked, and shutdown for 
shipping.  By following the instructions in this quick start guide, you can get your SMiRF® up and 
running quickly and easily.

Your SMiRF product kit includes:

• Aceeca rugged PDA

• MeshPlus SMiRF module (installed in PDA)

• USB or Serial sync and charging cable

• Charging power supply

• Sync software on CD or DVD

• SMiRF® FST software on CD or DVD
Additional options include:

• Extra batteries

• USB cradle for PDA charging, sync, spare battery charging

• Softickk PPP software for USB Sync

• Bluetooth (PDA factory option) for Bluetooth Sync

• GPRS mobile field sync cradle

• Hand Strap

• Belt storage/carry pouch

A typical installation also requires a desktop or laptop computer running a Microsoft Windows 
operating system such as Windows XP, Vista, or 7.  

The SMiRF® can be used stand-alone to install MeshPlus MIUs such as meter interface units 
(MIUs) or in conjunction with other MeshPlus® MeshMaster software to provide centralized work 
order management for field installations, reading, and service.  Both methods are described in 
this guide; installation and configuration of MeshMaster is described in the MeshMaster 
documentation set.

Please refer to the user's guide for each product for details on their operation.  This guide 
provides basic installation and configuration guidance for the SMiRF-specific aspects of these 
software products.

This manual will help you get your SMiRF configured and running.
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Quick Tour
Let's examine the SMiRF:

The SMiRF is a rugged waterproof Aceeca PDA that uses a touch-sensitive screen and 
directional buttons for user interaction.  The built-in MeshPlus SMiRF module adds wireless 
communication with other MeshPlus devices and a Global Positioning System (GPS) receiver for 
location services.

The SMiRF has a built-in stylus for precise selection of items on the screen, a field-removable 
battery pack, and a waterproof connector for charging and communications.

SMiRFs are available with FSTN (gray-scale) and TFT (color) displays; all displays have back 
lighting available for use in low-light conditions.  A variety of accessories are available including 
hand straps, charging cradles, spare batteries, belt carry pouches, and automotive cradles.  For 
more details on the PDA hardware and accessories, refer to the Aceeca PDA user manuals and 
website: http://www.aceeca.com
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Navigation

Press the Power button to turn on the PDA.  The PDA application laucher 
shows a list of all the software that is installed on the PDA.  Locate the 
SMiRF application software icon then launch the software by tapping the 
icon with your  finger or stylus.  
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The 

SMiRF application software will first check and configure the SMiRF Module installed in the top of 
the PDA.  If the module is not found or is not working properly, the software will display an error 
message and exit; otherwise, the SMiRF application software will start and the home page will be 
displayed.

Home Page

The SMiRF application home page provides quick-launch 
buttons for the most common operations:

• Tasks – opens the list of work orders

Copyright 2013, Axiometric, LLC Page 10 Confidential
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• Install – ad-hoc installations

• Read – ad-hoc reading/data collection

• Exit – quit the FST applications

The name of the configured technician (user) for this PDA is displayed at the top of the 
screen.

The home page also provides a menu button in the top-left corner to access the program 
main menu.  To launch any of the home page operations, tap the desired operation with 
the stylus.

Main Menu

The SMiRF application software provides pull-down menus to navigate 
among the various functions. To access the pull-down menus, use the 
stylus to tap either the word “Menu” in the top left corner of the screen or 
the pull-down menu icon in the lower left corner of the screen, then tap on 
a pull-down menu.  

File Menu

The File menu offers access to common functions quickly.  To access one of the 
functions, tap it with the stylus.  These functions are typically used  to install and manage 
devices that have not been assigned as tasks in MeshMaster; for example repeaters or 
demonstration or pilot MIUs.

▪ Home
At any point, you may choose Menu->File->Home 
to return to the Home Page.

▪ Install
To begin installing an MIU without a work order, 
select Menu->File->Install.  Some devices such 
as MIU repeaters typically do not have associated 
work-orders and are installed this way.  You will 
be prompted to fill in the data required for a 
successful installation.  Do not use the Install 
menu function to install devices that have an 
associated work order.

▪ Read
To read an MIU and store the results without a work order, select Menu->File-
>Read.  Do not use the Read function to read devices that have an associated 
work order.

▪ Service
For advanced MIU diagnostics and service, tap Menu->File->Service.  The 
Service operation allows technicians to check a remote device's radio, battery 
and power status, and to perform operations such as software upgrades and 
taking an MIU out of service (e.g. for shipping).
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▪ Exit
Exit the FST application and return to the PDA launcher.

Tasks Menu

Most field service operations such as installing, reading, and maintaining devices should 
be managed using the MeshMaster service management system.  The MeshMaster 
system creates work-orders (tasks) and assigns them to specific field service technicians 
or field service teams.  When the SMiRF is synchronized with MeshMaster, it downloads 
the list of tasks for its technician and presents them in the 
order in which they should be performed.

▪ Open
Opens and displays the list of work orders (tasks) 
to be completed.  Work orders are created and 
assigned to field technicians or teams with 
MeshMaster and downloaded to the SMiRF PDA 
during Sync operations.  The work orders are 
presented in the order in which they should be 
performed.

▪ Sync
Uploads completed work orders (tasks) to 
MeshMaster for storage and processing.  The list 
of work orders is then cleared and all open work 
orders are downloaded from MeshMaster to the PDA.  During the Sync operation 
other information may also be downloaded such as new firmware for MIUs or for 
the SMiRF itself.  In order to synchronize, the SMiRF must be:

• connected to a PC/workstation via USB cradle or cable

• connected to a PC/workstation via Bluetooth wireless connection

• connected to the internet via a GPRS mobile cradle

Synchronization may only be performed when the SMiRF has access to the 
internet via one of the above methods.  The synchronization configuration and 
process is described in detail later in this guide.

Setup Menu

SMiRF configuration is performed via the Setup menu. 
Configuration settings are stored persistently and remain set 
until changed or until all settings are cleared by resetting the 
SMiRF to its factory configuration.

▪ Wireless
Configures the MeshPlus wireless radio 
communication settings such as SSID and radio 
mode.

▪ Hardware
Displays the SMiRF module hardware information such as revision, data of 
manufacture.  Additionally displays any problems or important alerts and allows 
the user to reset the SMiRF module.

▪ Firmware
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Displays the SMiRF module operating firmware and firmware stored for 
upgrading other MeshPlus devices.  Firmware is automatically loaded into the 
SMiRF during task synchronization and then installed on the SMiRF module 
when the software restarts. 

▪ Preferences
User preferences such as whether to allow handwriting recognition (Graffiti), 
whether to require GPS coordinates for all installations, etc. are configured and 
stored using user Preferences.

▪ Defaults
Use Defaults to change default installation settings such as the default number of 
register dials or multipliers for pulse registers.  Default settings are stored 
persistently in the SMiRF. 

▪ Server
The MeshMaster server provides service management via work orders as well as 
access to firmware upgrades and other data.  In order for the SMiRF to 
synchronize with the MeshMaster server, it must be configured with the 
appropriate internet address and security information.

▪ User 
The MeshMaster manages work orders for a user.  In order to get the specialized 
work orders for a user (technician), the user's login name and password must be 
configured.

Help Menu

The Help menu provides information about the SMiRF 
application software and several advanced diagnostic 
features.

▪ GPS
Provides detailed status regarding the state of 
the GPS satellite receiver.

▪ About
Displays information about the SMiRF 
operating environment and software version.
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Setup and Configuration
Configuration of the SMiRF is performed using the Setup pull-down menu functions. 
Each pull-down menu choice opens a form (a graphical user interface) that displays 
information about the current settings and configuration and allows them to be changed. 
Changes are stored persistently.

Wireless Setup

To communicate with other MeshPlus and StarPlus devices, the SMiRF module 
contains a radio and configurable controller.  When the SMiRF module is 
communicating with a remote device or is waiting for a remote device to 
communicate with it, and the wireless link icon is displayed in the upper right 
corner of the display.

To successfully communicate with other MeshPlus and StarPlus devices, the 
radio controller must be configured to match the remote devices:

Mesh – MeshPlus mode wherein devices communicate with 
each other to form a fixed network; messages “hop” from device 
to device until they reach a gateway that stores and forwards 
the message to the internet.

Drive-by – StarPlus mode wherein devices only communicate 
with StarPlus controllers, typically mobile devices in a van or 
handheld devices such as a SMiRF.

To change the mode of operation, tap the desired mode with 
the stylus.  Your MeshPlus system administrator can tell you 
the proper radio mode of operation.

Each MeshPlus or StarPlus deployment may also be assigned a unique Service Set Identifier 
(SSID) that is used to prevent one deployment from interfering with another. The SSID consists of 
8 digits where each digit can be either 0-9 or A-F.  Your MeshPlus system administrator can tell 
you what the proper SSID is for your deployment.

To change the SSID, tap each digit and choose the desired letter or number from the list that 
appears.  After you choose a digit, the next digit's list will automatically open.  When you are done 
making changes, tap anywhere outside the open list.

Once changes have been made to the wireless configuration, press the “Apply” button; this will 
cause your changes to be saved permanently.  In some cases, you may also need to reset the 
radio and controller by tapping the “Reset” button; you will be prompted to do this if it is required.
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devices if the wireless settings on your SMiRF and the other devices do 
not match.
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User Preferences 

Users may configure aspects of how the SMiRF operates for convenience and to prevent errors. 
The initial (default) user preferences are shown to the right and are discussed below:

Allow Graffiti 

The SMiRF provides two methods for text and number 
entry: virtual keyboards and handwriting recognition.  

Handwriting recognition uses an engine and style called 
“Graffiti”.  Using graffiti, the user traces block letters in 
the graffiti pad area of the touch-screen:

Letters are traced in the left portion of the graffiti pad and numbers in the right portion. 
Experienced users can enter data, especially numbers, very quickly using graffiti and 
often find it faster than choosing letters or numbers on a virtual on-screen keyboard. 
However new users may be confused if they select a data entry field and a virtual 
keyboard is not displayed.  As a result, the default user preference is not to allow graffiti: 
when a data entry field is selected, a virtual keyboard is automatically displayed.  

If the “Allow graffiti“ box is checked, the keyboard 
will not automatically be displayed and the user is 
free to enter data using graffiti handwriting 
recognition.  Users can always pop-up a virtual 
keyboard on demand by tapping the abc and 123 
dots in the graffiti pad area.

For more information on Graffiti go to the manual for the Meazura MEZ1000 RDA, pages 
24-29.

Require GPS 

When installing new equipment, it is important to record the GPS location.  Several of the 
mapping features of MeshMaster and some aspects of MeshPlus fixed networks depend 
on having accurate GPS location data for each device.

When the “Require GPS” preference box is checked, installation of new equipment is not 
permitted unless the GPS location has either been provided in advance (in a work order) 
or the current location is detected by the GPS receiver in the SMiRF.

In some cases, it may be necessary to turn this protection feature off; for example when 
demonstrating the operation of a SMiRF indoors where no GPS signal is available, 
however in general GPS should be required for device installation.
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Show Wiring Hints

Many MeshPlus devices are connected to other 
equipment that is monitored and controlled by the 
MeshPlus device.  For example utility meter interface 
units (MIUs) are typically connected to utility meter 
registers using three wires.

When wiring hints are enabled, an alert box pops up 
when it is time to make a wired connection showing the 
proper color wires to use for the type of device being 
connected and where to connect them.

Wiring hints may be very helpful for a new technician when installing equipment, however 
for experienced technicians, hints become just another button to press.  Experienced 
technicians can suppress these pop-ups by un-checking the preference box to “Show 
wiring hints”.

preference is set to “Always” the SMiRF will automatically upgrade the embedded MIU 
software without asking.  With the “Never” option selected, the upgrade is not done 
automatically nor is the technician asked, but a button is displayed during the install 
process to allow the technician to to manually upgrade the software if desired. 

When the user preferences have been set as desired, press the “Back” button to return to 
the Home Page.

Defaults

Defaults are used to eliminate repetitive steps when installing 
multiple MIUs of the same kind.  Set the default values to the 
configuration required for the common MIU type. Then during 
installation these fields will start with the correct values. 

For example, when installing an MIU connected to an encoded 
register, it is necessary to configure the number of moving and 
painted dials for accurate readings.  (see Install).  If most MIUs will 
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be installed on registers with 6 moving dials and 1 painted dial, set the defaults appropriately to 
save time during each MIU installation.

Similarly, when installing an MIU connected to a pulse register, the default settings for pulse 
constant and pulse ratio may be configured to avoid the need to enter that data during each MIU 
installation.. 

Server Setup

In order for the SMiRF to communicate with the MeshMaster server software, it must be 
configured with the internet connectivity information to locate the server.

The server configuration includes the following:

Host – domain name (e.g. meshplus.com) or an IP 
address (e.g. 96.244.83.43) of the MeshMaster web 
application server .

Port – The TCP port used to connect to the MeshMaster 
web application.  The default port is 8080 but may be 
configured to any port by your MeshPlus system 
administrator.  Your MeshPlus system administrator 
should tell you what port to use.

App – The name and path to the MeshMaster web application on the server.  Your 
MeshPlus system administrator should tell you what application path and name to use.

Site – A single MeshMaster web application may manage multiple MeshPlus 
deployments.  The site name specifies which deployment the SMiRF will be servicing. 
Your MeshPlus system administrator should tell you what site name to use.

User 

In order to download assigned work orders from MeshMaster, you 
need to enter your MeshMaster account information.  

User – Each user in a MeshMaster system is assigned a 
user name and password.  You should enter your assigned 
user name here.  This user name is used to authenticate with 
the MeshMaster web application server and to select which 
work orders are downloaded to the SMiRF.  Your MeshPlus 
system administrator should tell you your user name.

Password – Each user in a MeshMaster system is assigned a user name and password. 
You should enter your assigned password here.  You can change your password using 
the MeshMaster web application.  Your password is not shown after it has been entered; 
stars are shown in place of the password to protect your privacy.  If you select the 
password field, a dialog will pop up to allow you to enter a new password; your old 
password will not be displayed.  Enter your password using graffiti or the pop-up 
keyboard (press the abc dot) and press the “Save” button when finished.  If you press the 
“Cancel” button, your password will not be changed.

When you are finished configuring the User settings, press the “Back” button to return to 
the Home Page.
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Tasks

Sync

The sync operation is used to upload completed work 
orders to MeshMaster and to download a field technician's 
tasks for the day.  The sync operation is expected to be 
used at the beginning and the end of each work day.  The 
Sync function is available under the “Tasks” menu.  Tap 
the Sync button to submit completed tasks, download new 
tasks and download updated firmware.  After Sync is 
finished, a window provides a summary of the  activity. 

Work-orders

At the start of each work day, technicians should sync their 
SMiRF to receive a list of the latest work-order (task) 
assignments.  To access these work-orders tap “Tasks”.  The 
screen will change showing the open tasks with each task on 
its own page. 

The information for each task includes:
Task - What  to do (e.g. Install or Read)
Notes - Important account notes; for example, a note 
to call the homeowner before accessing the property 
or a warning about a guard dog.
Meter - The water meter Id, usually stamped on the 
side of the brass water meter and useful for confirming that the task is being performed at 
the proper customer location.
Address - The address to find the meter/MIU.  Tapping the address box with the stylus 
will give you more additional information about the location.
Done - Checked if the task has been completed.  To change the status of a task to 
incomplete, tap the check mark.

Buttons are provided to assist with finding specific tasks 
and starting work on the task:

• Search - Allows technician to enter an address, 
partial address, meter ID, or partial meter ID; the 
list of tasks are then automatically searched for a 
match. 

• Skip – If a task cannot be completed (e.g. if the 
property cannot be accessed), allows the 
technician to record the reason the task is being 
skipped.
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• Back - Returns to the home page

• Start – Starts work on the task (please refer to the appropriate section for that type of 
task for the next steps) 

• Nearest – Finds the nearest task  based on the current GPS location.  

A filter selector in  the top left corner of the screen can limit which 
tasks are shown to make navigation easier.  By default, all tasks 
are displayed, however the displayed tasks may be limited to only 
open tasks or only completed tasks.  Tap the arrow next to the 
current filter choice to select which tasks should be displayed.

Task Navigation
On either side of the address are 
arrow keys that allow the technician 
to move through the list of tasks.  The single arrow moves to the 
next or previous tasks; the double arrows move forward or 
backwards through the list of tasks 10% at a time (for example, 
with a list of 200 tasks, pressing the double-right-arrows will 
advance 20 tasks).

Install Tasks
MIU installations are typically performed in response to an assigned work-order (task).  MIUs may 
also be installed independently by a technician (e.g. for a demonstration or as a repeater to 
extend range).  The installation processes for task assigned and independent installs are very 
similar.  They are described below and the differences are noted.

To install an MIU without a work-order, tap “Install”.  Then select 
the type of MIU to be installed.

When connecting an MIU to an absolute encoder or pulse register, 
the software displays wiring hints for connecting the MIU to the 
register.  After correctly wiring the devices, tap “OK” to continue. 

If the MIU location and meter ID 
have not already been provided in 
the work-order, a form is presented 
for the technician to enter the  Meter Id, Address, City, and State. 
If installing a Repeater there will be no Meter Id.  The Meter ID and 
the Address are required fields. You may not proceed without filling 
out all of the required fields.

Once a city and state have been entered, they are automatically 
filled in for subsequent installs unless manually changed.
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When connecting an MIU to a water 
meter register, enter the number of 
moving and painted dials.  Tap on 
the numbers to adjust them to match 
the dials  on the face of the register 
being installed.  

If the MIU is being connected to a 
pulse register,  you must also set the 
initial register reading, the pulse 
constant and pulse ratio.  

To set the initial reading, tap the moving dials and pick their 
proper values from the list shown.  Your system administrator 
should provide the pulse constant and ratio  values.  The pulse 
constant is a multiplier applied to each pulse from the register, the 

pulse ratio is a divisor.  For example, to configure a register that generates a pulse for every 5 
gallons consumed, enter a pulse constant of 10 and a pulse ratio of 2.

Consumption = Pulses x Constant / Ratio

When done tap, “Next”. 

When the SMiRF prompts you to activate the MIU, place a magnet 
against the activation location on the MIU.  When the MIU has 
been successfully activated, it will initiate radio communication with 
the SMiRF and in a few seconds the SMiRF will beep to indicate 
that the MIU has been detected; it will then gather information 
about the MIU using radio communications and display it on a 
screen for review.

It is critical to confirm that this 
information is correct, especially the 
MIU ID.  When many technicians are 
working in the same area, it is possible that the SMiRF received a 
message from a different MIU that was activated by another 
technician.  It is very important to check the Meter Id and MIU ID to 
ensure the installation is properly recorded.  If any of this data is in 
error, tap “Back” and correct it.  When everything is correct tap 
“Next”.

The SMiRF performs the installation using the entered data and the 
acquired GPS information.  If GPS information is not available an 
warning message is displayed.  Upon successfully installing the 
device an installation summary window is shown for review.  When 
done evaluating the information, tap “OK”. 
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Read Tasks
MIU reads are typically performed in response to an 
assigned workorder (task).  MIUs may also be 
independently read by a technician to collect the latest 
register reading.  The read process is very similar for 
assigned and independent reads: Press  “Read” on the 
Home page for an independent Read.  When prompted, 
activate the MIU  to be read by placing a magnet on the 
activation location on the MIU.  When the MIU has been 
successfully activated, it will initiate radio communication 
with the SMiRF and in a few seconds the SMiRF will beep 
to indicate that the MIU has been detected; it will then 
gather reading and status information from the MIU using radio communications and 
display it on a screen for review:

• Meter - Meter Id

• MIU – MIU serial number 

• Reading - The last register reading recorded by 
the MIU.  Pulse registers always return the 
current reading as shown on the face of the 
register.  Encoded registers are read hourly and 
the reading returned will be accurate within the 
last hour.

• Firmware - The current MIU firmware version 

• Battery - the MIU battery voltage

• Alerts - any alerts (problems) on the MIU

It is critical to confirm that this information is correct, especially the MIU and Meter ID. 
When many technicians are working in the same area, it is possible that the SMiRF 
received a message from a different MIU that was activated by another technician.  It is 
very important to check the Meter Id and MIU ID to ensure the reading is properly 
recorded.

When done viewing the reading information, tap “OK”.  If completing a task, you will 
return to the workorder/task display.  If completing an independent read, you will return to 
the activate MIU screen ready to perform another reading.
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Setting up your PC

Installing Palm Desktop Software

The following instructions guide you through installing Palm Desktop so that you can transfer 
updated software from your computer to your SMiRF.  After installation, refer to the online Help in 
Palm Desktop for information on how to use the software.

To ensure a safe and uninterrupted installation of Palm Desktop

Do the following before installing:

• Turn off your computer and connect the cradle/communications cable to it.  Do 
not place your SMiRF (PDA) in the cradle or connect it to the communications 
cable until instructed.

• Do not copy the Palm Desktop files to your computer's hard disk.  You must use 
the installer to place the files in their proper locations and to decompress the 
files.

Installing Palm Desktop Software on a Windows computer

1. Exit any open programs, including those that run at startup (such as Microsoft 

Office), and disable any virus scanning software.

2.  Insert the Meazura™ Desktop CD into the desktop computer's CD-ROM drive.

3. Follow the onscreen instructions to complete the installation.  During installation, 

you may be asked to insert your SMiRF (PDA) into the cradle or connect it to the 

communications cable.

Upgrading your Palm Desktop Software

To upgrade Palm Desktop, follow the steps below:

1. Synchronize your old SMiRF (PDA) with your old Palm Desktop to ensure that the 
latest information from your SMiRF is backed up to your desktop computer.

2. (Optional) To prevent data loss, go to the folder that stores Palm Desktop (for example, 
C:\  Program   Files\Palm), copy the folder and its contents, rename it (for example, Palm 
Backup), and store the copy outside the Palm Desktop folder.

3. Make sure you installed the new software in the same folder as the old software.

4. To prepare for the first HotSync operation that will synchronize your  SMiRF with your 
new Palm Desktop, go to the HotSync Manager and choose Custom.
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NOTE
If the installation does not begin, click the Windows Start button, choose Run, enter 
D:\install_menu.exe, and then click OK.  If necessary, replace D: with the drive 
letter assigned to your CD-ROM drive.
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5. For all conduits, click Change, and select the Desktop overwrites handheld option. 
Then click OK. 

6. Connect your new SMiRF handheld to your desktop computer with the 
communications cable or  USBcradle and press the HotSync button.  For more 
information on how to do this refer to your Quick Start Guide included in your kit. If the 
Select User dialog box appears on your desktop computer, select your username.

For more information on the HotSync process please refer to the Meazura MEZ1000 RDA 
handbook pages 91-94. 

Setting up a WorkStation
In order to connect the PDA to the internet to allow to sync to download or upload tasks 
to a server. The PDA needs an internet connection. The SMiRF supports 3 methods:

1. USB Cradle/cable + a 3rd party program called Softickk PPP 
http://www.  Softickk  k.com/ppp/  

2. Bluetooth internet connection

3. GPRS cradle connection 

Softick PPP

Softick PPP allows the SMiRF to access the Internet or a Local network through your 
laptop/desktop PC.  The Softick enables PPP communications over the SMiRF 
cradle/cable USB connection.  With Softick PPP a user can synchronize with a remote 
MeshMaster server (upload completed tasks, download new tasks and other data). 
Softick PPP is available here: http://www.softick.com/ppp/

The Softick website and manual provide installation and configuration information.

Softick PPP requirements

• A Palm OS (PDA) 

• Windows 7

• Palm Desktop 4.1 or higher Installed

• USB or Bluetooth/Serial connection
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NOTE
Select your username, if it does not already appear in the box.

NOTE
For the conduits named, "Install", "Install Service Templates" and "Install To Card", 
Desktop overwrites handheld is not an option. These should remain Enabled.
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Maintaining Your Handheld

Environmental Factors

Storage Conditions

Store the SMiRF in a cool dry place.

Operating Conditions

While operating the SMiRF please ensure it is free of moisture, particularly when 
operating around electrical equipment.  The SMiRF is waterproof and dustproof  and can 
be operated in most environmental conditions.  We do not recommend operating the 
SMiRF in extreme conditions (e.g. underwater for long periods, in extreme hot and cold 
environments, or at extreme altitude).

Cleaning Your SMiRF

When removing mud or other debris from the SMiRF, use a damp cloth and a soft bristle 
brush and completely dry the SMiRF before use. 

Maintaining your Battery Pack

Changing the Battery

Before changing the battery to save data on the PDA by performing a backup the SMiRF 
so no data is lost. After Backing up the SMiRF Follow the directions below to change the 
battery:

1. Either perform a HotSync or perform card backup to save any data in the SMiRF

2. Remove the battery clip

3. Remove the old battery

4. Install the new battery

5. Replace the retaining clip

6. Sync or restore the card backup depending on what you did in step one. 

Battery Usage

The SMiRF comes with a rechargeable Lithium Ion battery pack that can be purchased 
from Aceeca or participating resellers.  The battery life between charges varies with 
usage but typically allows up to 30 hours of continuous use.
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Warning 
For safety reasons, ensure that the SMiRF is completely dry before charging and 
operating near electrical equipment. 
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Battery Warnings

• Do not heat or throw the battery into a fire.

• Do not use or store the battery close to fire or inside a car in which the 
temperature may be over 60°C.

• Do not put the battery in your pocket or in a bag together with metal objects such 
as necklaces, hairpins, coins, or 97 screws.  Do not store the battery with such 
objects.

• Do not short circuit the (+) and (-) terminals with a metal object such as a needle, 
necklace or hairpin.

• Do not pierce the battery with a sharp object such as a nail.

• Do not hit with a hammer, step on, throw, drop or allow the battery to undergo 
other such strong shock.

• Do not disassemble or modify the battery.

• Do not solder the battery directly.

• Do not use a battery that is severely scarred or deformed.

Battery Storage

Unlike NiCd (Nickel Cadium) batteries or NiMH (Nickel-metal Hydride) batteries, lithium-
ion batteries should be charged early and often.  When not in a device the battery should 
be kept at charge level of around 40%.  Never use battery maintenance software to 
maintain your battery as this can reduce the life of your battery.  Li-ion batteries should 
be kept cool.  Ideally stored in a refrigerator.  They should not be subjected to freezing 
temperatures.  Aging will occur much faster at high temperatures (such as a hot car) and 
will reduce the life of your battery.  Purchase a Li-Ion battery pack only when you need a 
replacement, ensuring you receive a fresh battery pack.

• Do not use the battery with dry cells or other primary batteries, or batteries of a 
different package, type, or brand.

• Stop using the battery if it exhibits abnormal heat, odor, color, deformation or is in 
an abnormal condition.

• Keep away from fire immediately when leakage or foul odor is detected.

• If liquid leaks onto your skin or clothes, wash well with fresh water immediately.

• If liquid leaking from the battery gets into your eyes, do not rub your eyes.  Wash 
them well with clean water and consult a doctor immediately.

• Before using the battery, be sure to read the user's manual and cautions on 
handling thoroughly.

• For information on installing and removing the battery from equipment, thoroughly read 
the user's manual for the specific equipment.

• Batteries have life cycles, so if the time that the battery is powering the equipment 
becomes much shorter than usual, the battery life is at an end.  Replace the battery with 
a new one.

• Remove a battery whose life cycle has expired from equipment immediately.

• When the battery is discarded, make it non-conducting by applying vinyl tape to the (+) 
and (-) terminals.  The battery must either be discarded as specified by the relevant local 
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body or put it in the recycling box of a store that is cooperating in the recycling of 
rechargeable batteries.

• When not using the battery for an extended period, remove it from the equipment and 
store it in a place with a low humidity and low temperature.

• If the terminals of the battery become dirty, wipe them with a dry cloth before using the 
battery.

• The battery can be stored within a -20°C to 40°C temperature range.

Battery Charging

The lithium-ion battery can provide between 300-500 charge/discharge cycles.  The 
lithium-ion battery is different from most other rechargeable batteries as charging from a 
partially charged battery keeps the battery in good condition whereas other batteries 
perform better when fully discharged  before recharging again.  Fully discharging the 
lithium-ion battery should be avoided wherever possible.  For most users, charging the 
battery at the end of each day is the ideal choice.  The lithium-ion battery pack typically 
lasts about 2-3 years, but potentially longer if cared for properly.

• When charging the battery, use dedicated chargers and follow the specified 
conditions.

• Do not use or charge the battery close to fire or inside a car in which the 
temperature may exceed 60°C.

• Stop charging the battery if charging is not completed within the specified time.

• Thoroughly read the user's manual for the charger before charging the battery.

• The battery can be charged within a 0°C to 45°C temperature range.

• Use the battery only in the specified equipment.

• Do not charge the battery in a place where static electricity is generated, or let the 
battery touch something that is statically charged.

Recycle and Disposal Methods

Lithium ion batteries, like all rechargeable batteries are recyclable and should be 
recycled.

Backing up the SMiRF

The SMiRF software and data collected are stored in 
volatile memory inside the SMiRF; volatile memory is 
only retained while power is present.  In order to have 
a back up for your SMiRF software and all data 
collected, you should backup your SMiRF regularly. 
To backup the SMiRF:

1. Locate the “CardBkup” application
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CAUTION
If your battery is damaged, or if it no longer holds a charge, dispose of it promptly and 
properly.  Do not dispose of it along with general waste.  Call your local waste disposal 
agency or environmental agency for advice on disposing of the battery.
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2. Launch the CardBkup application

3. Tap “Backup Now”

4. Select the memory card to receive the backup

5. Assign a name for the backup

6. Tap “Begin Backup”

7. The SMiRF will backup all the data on the Card

8. When the backup is finished, tap “Done”

Refurbishment Services

Aceeca offers refurbishment services for your PDA. The types of services that exist are:

• Replacement of touchscreen

• Replacement of gaskets and keypad

• Refitting of module

• Refurbishment of damaged exterior

For more information about the refurbishment process, please contact Aceeca through 
their website at http://www.aceeca.com.

Trouble Shooting Section 

Restart Software

A soft reset allows your RDA to get a fresh start, similar to rebooting a desktop computer. All 
records and

entries are retained after a soft reset.

To perform a soft reset, press and release the Power and Backlight button together.
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Restart Hardware

A hard reset will erase all records and entries stored in your PDA. NEVER perform a hard 
reset unless a soft reset does not correct your problem. Always ensure you have backed 
up your data, if possible, before performing a hard reset on your PDA. You can restore 
any data the you previously backed up to your card. 

To perform a hard rest, do the following: 

1. Press and hold the Power and Backlight buttons together, then release the Backlight 
button only.

2. Release the Power button when the SMiRF Powered logo appears.

3. Follow on-screen instructions:

• If you want to abandon the hard reset, press the down arrow button. 

• If you want to continue with the hard reset, press the up arrow button. 

Non-Synchronizing work-orders

If the work-orders are not synchronizing properly then check to see if the Handheld has a 
method to communicate with the internet installed or setup. Without a method to 
communicate with the internet the PDA cannot exchange information with the server.
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Note 

When you perform a hard reset, the current date and time are retained. Formats, 
preferences, and other settings are restored to their factory default settings.


